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Successful WebEx Meetings
Tips and techniques for meeting hosts and presenters
About This Guide

This guide, Successful WebEx Meetings, provides tips and techniques that you 
can use to conduct more effective meetings on the Web. This guide assumes 
that you are already familiar with the basics of your meeting service, and thus 
it does not provide detailed instructions for using your meeting service.

To obtain detailed instructions for using the options and features that 
this guide describes, refer to the online Help on your meeting service 
Web site.

Many of the tips and techniques in this guide were provided by meeting 
service users like yourself. If you have a tip that you want to share with other 
users, please send a detailed description of your tip to docs@webex.com.

Setting Up a Meeting

For meeting hosts

This section provides tips and techniques that can help you to set up a 
scheduled or instant meeting effectively.

Securing Your Meeting

You can provide security for your meeting by doing any of the following in the 
Schedule a Meeting Wizard:

■ Require a password—If you specify a password for the meeting, attendees 
must provide this password to join the meeting. 

■ Schedule an unlisted meeting—An unlisted meeting does not appear on 
the meeting calendar on your meeting service Web site. To join an unlisted 
meeting, attendees must click the Unlisted link under Attend a Meeting on 
the navigation bar, then provide a unique meeting number.
■ Exclude the meeting password from email invitations—If you have 
specified a meeting password, you can prevent the password from 
appearing in the email invitations that your meeting service Web site 
automatically sends to attendees. 

■ Require attendees to log in—You can require that attendees have a user 
account on your meeting service Web site. Thus, attendees must log in to 
your site before they can attend a meeting. 

■ Require attendees to register for the meeting—You can require each 
attendee to fill out a registration request that includes his or her name, 
email address, and other information that you require, and then send the 
request to you. You can then accept or reject each registration request.

The level of security that you choose depends on the meeting's purpose. For 
example, if you schedule a meeting to discuss your company picnic, you might 
specify only a simple password for the meeting. On the other hand, if you 
schedule a meeting in which you will discuss sensitive financial information, 
you may want to specify that the meeting is unlisted and require attendees to 
log in to your site to attend.

N o t e Once you start a meeting, you can provide additional 
security by “locking” the meeting. For details, see “Preventing 
Unauthorized Access to a Meeting in Progress” on page 5.

Scheduling a Recurring Meeting

If you want to host a meeting on a regular basis, you can specify one of the 
following recurrence patterns when scheduling a meeting:

■ daily recurrence

■ weekly recurrence

■ monthly recurrence
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■ yearly recurrence

To set up a recurring meeting, specify recurrence options on the Date & Time 
page in the Schedule a Meeting Wizard.

Including a Teleconference

When scheduling a meeting, you can select one of the following 
teleconferencing options on the Teleconference page in the Schedule a 
Meeting Wizard:

■ None—Select this option if you do not need to set up a formal 
teleconference or use a teleconferencing service—for example, if you want 
to meet with only one other attendee.

I m p o r t a n t If you schedule a meeting without using a 
teleconferencing service, it is recommended that you clearly 
specify in your email invitation how you plan to provide audio for 

the meeting; otherwise, attendees may not realize that your meeting 
includes audio. For example, you can inform attendees that you will call 
them once the meeting starts. To specify this information, you can create 
a custom email invitation. For details, see “Creating a Custom Email 
Invitation for Attendees” on page 3.

■ WebEx teleconferencing service—The meeting includes an integrated 
teleconference. If you select this option, select one of the following types of 
teleconferences: 

Attendees call in—Select this option if you want attendees to call a 
phone number to join a teleconference. 

Attendees receive a call back—Select this option if you want the 
teleconferencing service to call attendees to connect them to the 
teleconference.
I m p o r t a n t In a call-back teleconference, only meeting 
attendees who have direct phone lines can receive a call back from 
the teleconferencing service. If a receptionist answers the call from 

the service, or the attendee's phone system uses a recorded greeting for 
incoming calls, the attendee cannot receive a call back. However, an 
optional call-in phone number for the teleconference is always available in 
the Meeting window.

■ Other teleconferencing service—Select this option if you want to use 
another teleconferencing service provider or an internal teleconferencing 
service. If you type instructions for joining the teleconference in the box 
that appears, the instructions automatically appear in a message box once 
an attendee joins the meeting.

Including an Internet Phone (VOIP) Conference

When scheduling a meeting, you can choose to use Internet phone in addition 
to or instead of a teleconference. This option allows attendees to speak to each 
other using voice over IP (VOIP)—an Internet-based telephony service—
rather than the traditional telephone system. An Internet phone conference 
can be either

■ half-duplex, which lets only one participant speak at a time

■ full-duplex, which lets up to two participants speak at a time

Internet phone can be useful in the following cases:

■ Your meeting includes remote attendees who do not want to be charged 
for long-distance phone calls. 

■ Your meeting will not involve much interaction—for example, attendees 
will listen to a presentation instead of engage in a discussion.

N o t e An Internet phone conference does not start automatically 
once you start a meeting. You must start the Internet phone 
conference as follows: On the Tools menu, point to Internet Phone, 

and then choose Start Conference.



3 of 14Sucessful WebEx Meetings: Tips and Techniques for Meeting Hosts and Presenters
For more information about using Internet phone, including system 
requirements, refer to the online Help on your meeting service Web site.

Granting Privileges to Attendees

When scheduling a meeting, you can grant privileges to or remove them from 
attendees, using the options on the Attendee Privileges page in the Schedule a 
Meeting Wizard. The privileges that you select determine whether all 
attendees can share documents, view shared documents independently, 
annotate shared documents, and so on. 

For most meetings, it is recommended that you accept the default privileges, 
and then grant additional privileges as needed to all attendees or individual 
attendees during the meeting. That way, you can maintain more control over 
the meeting. For example, if you are giving a presentation and want to ensure 
that attendees follow along with your slides, you probably do not want to 
grant them the View any page privilege, which lets them navigate your 
presentation independently.

Letting Attendees Join a Meeting Before Its 
Scheduled Starting Time

You can let attendees join a meeting before you actually start it. For example, 
you can specify that attendees can join a meeting up to 10 minutes before its 
scheduled starting time. This option, which is available on the Date & Time 
page in the Schedule a Meeting Wizard, helps to prevent attendees from 
having to wait for you to start the meeting before they can join it.

If you do let attendees join a meeting early, you can automatically share a 
presentation or document once an attendee joins the meeting. For details, see 
“Sharing a Presentation Automatically” on page 3.

Sharing a Presentation Automatically

If you let attendees join a meeting before its scheduled starting time, you can 
share a presentation or document automatically. The presentation or 
document can inform or entertain attendees while they are waiting for you to 
start the meeting. 
To share a presentation or document automatically, you must select it when 
scheduling a meeting. The presentation or document must be in the WebEx 
Universal Communications Format (UCF). To save any document or 
presentation as UCF, use the WebEx Universal Communications Toolkit or 
the WebEx Document Manager, which are available on the Support page on 
your meeting service Web site.

Creating a Custom Email Invitation for Attendees

If you invite attendees to a meeting when scheduling it, your meeting service 
automatically sends invitation email messages to the attendees. However, you 
can modify the automatic email message, as follows: Initially invite only 
yourself to the meeting. Once you receive the invitation email message, you 
can modify it as needed, and then forward it to attendees. In your custom 
invitation email message, ensure that you include all necessary meeting 
information that the original message contained, such as the date and time for 
the meeting, the meeting agenda, the URL for joining the meeting, and voice 
conferencing information.

N o t e Do not modify the meeting confirmation email message 
that you receive. This message contains information and URLs that 
you need to host the meeting.

Changing Information About a Scheduled Meeting

You can update any information about a meeting, including its starting time, 
recurrence pattern, or list of invited attendees. Once you modify a meeting, 
you can choose to send attendees a new invitation email message that informs 
them that you have modified information about the meeting. Attendees 
whom you removed from the attendee list receive an email message informing 
them that you have retracted their invitations.
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Letting Another User Schedule a Meeting on Your 
Behalf

You can grant permission to one or more meeting service users to schedule 
meetings on your behalf. Once another user schedules a meeting for you, the 
meeting appears in your list of meetings on the My WebEx Meetings page. You 
can then start the meeting and host it as you normally can when you schedule 
meetings yourself. 

To let another user schedule a meeting for you, specify that user in your user 
profile on your meeting service Web site. You can select only a user who has 
an account on your meeting service Web site.

Using Microsoft Outlook to Schedule a Meeting

If you use Microsoft Outlook 2000, and your meeting service includes the My 
WebEx Integration to Outlook option, you can schedule, start, and join online 
meetings using Microsoft Outlook. For instructions on using Integration to 
Outlook, refer to the guide My WebEx Integration to Outlook User's Guide. 
This guide is available on the Support page on your meeting service Web site.

Using One-Click Meetings

If you often meet with others to spontaneously collaborate on documents, 
spreadsheets, and so on, you can set up One-Click Meeting shortcuts for your 
Microsoft Office applications. Then, while working in a Microsoft Office 
application, you can instantly start a meeting and share the document that is 
open in that application. 

Similarly, you can set up a One-Click Meeting shortcut for your Windows 
shortcut menu. This shortcut lets you right-click any document or application 
on your computer to instantly start a meeting and share that application or 
document in the meeting.

To set up One-Click Meeting shortcuts, use the One-Click Meeting Wizard, 
which is available on your My WebEx Meetings page.
Starting and Conducting a Meeting

For meeting hosts

This section provides tips and techniques for starting and conducting a 
meeting.

Starting a Scheduled Meeting

Meetings do not start automatically at their scheduled times. As the meeting 
host, you must first start a meeting before attendees can join it. Thus, it is 
recommended that you start a meeting about 10 minutes before its scheduled 
starting time, to accommodate any attendees who want to join a few minutes 
early.

Alternatively, you can let attendees join a meeting before you actually start it. 
In this case, the meeting automatically becomes “open” at a time that you 
specify when scheduling it. For more information, see “Letting Attendees Join 
a Meeting Before Its Scheduled Starting Time” on page 3.

Helping Attendees to Find Your Meeting Service Web 
Site

If attendees have trouble finding your meeting service Web site to join a 
meeting, verify that they are using the correct URL. Some common mistakes 
that users make are the following:

■ Typing www in the URL. Meeting service Web sites do not include the www 
server name. Instead, these sites include your organization's name, in the 
following format:

http://<your_organization_name>.webex.com

■ Typing webx instead of webex in the URL.

■ Typing http instead of https, if your site is secured with SSL (Secure 
Sockets Layer). A secure site's URL has the following format:

https://<your_organization_name>.webex.com
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Helping Attendees to Join a Meeting

If attendees have trouble joining a meeting, they may be attempting to join a 
meeting that you have not yet started. On the meeting calendar on your 
meeting service Web site, under Status, the text Join Now and a green 
indicator appear only after you start the meeting. Otherwise, the text Not 
started appears.

Because a meeting’s status can change at any time, an attendee can 
periodically click the Refresh button on the page to determine whether you 
have started the meeting.

You can help to avoid the need for attendees to refresh the meeting calendar 
by letting them join the meeting before you actually start it. For details, see 
“Letting Attendees Join a Meeting Before Its Scheduled Starting Time” on 
page 3.

Preventing Unauthorized Access to a Meeting in 
Progress

Once all required or invited attendees have joined a meeting, you can “lock” 
the meeting by restricting access to it. Restricting access to a meeting prevents 
anyone else from joining it. To lock a meeting, choose Restrict Access on the 
Meeting menu. 

Helping Attendees to Join a Teleconference

If your meeting includes an integrated call-in or call-back teleconference, or a 
third-party teleconferencing service, instructions for joining the 
teleconference automatically appear in a message box on an attendee’s screen 
once that attendee joins the meeting. Attendees can also obtain instructions 
for joining a teleconference at any time during the meeting, by choosing Join 
Teleconference on the Participant menu. If your meeting includes an 
integrated call-in teleconference, the call-in number also appears on the Info 
tab in the content viewer.
Using Internet Phone (VOIP)

If, when scheduling or starting an instant meeting, you included an Internet 
phone conference, you must start the conference after you start the meeting, 
as follows:

On the Tools menu, point to Internet phone, then choose Start Conference.

Before starting or joining an Internet phone conference, you can use the 
Audio Setup Wizard—which is available on the Tools menu—to ensure that 
your microphone and speakers are set to their optimal levels.

For more information about using Internet phone and the Audio Setup 
Wizard, refer to the online Help on your meeting service Web site. 

Presenting Information

For presenters

This section provides tips and techniques for sharing presentations and 
applications, polling attendees, and recording meetings.

Preparing for Your Meeting

The following tips can help you to avoid problems and ensure that your 
meeting runs smoothly:

■ Before you start a meeting, ensure that your computer and network are 
working properly to avoid any unexpected problems during the meeting.

■ Place all the files that you intend to share in a single folder, so you can 
quickly locate them during the meeting.

■ Start your meeting early, and practice sharing the documents and 
applications that you intend to share with attendees. That way, you can 
troubleshoot any problems before attendees join the meeting.

■ Ensure that you have the URL for your backup meeting site handy, in case 
your primary site is unavailable. If you do not know the URL for your 
backup site, ask your meeting service site administrator.
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■ Once you start a meeting, write down the meeting number, host key, and, 
if you are using the integrated teleconferencing service, the teleconference 
number. These numbers appear on the Info tab in the content viewer.

Using an Assistant Presenter

If you want to focus on speaking during a meeting, or want to view your 
presentation from an attendee's perspective, you can assign the presenter role 
to another attendee. This attendee can “drive” the presentation, by advancing 
slides and sharing applications as you need them.

Personalizing Your Meeting with Video

If you attach a video camera to your computer, you can use video to introduce 
yourself at the beginning of a meeting. To send live video to participants, 
simply click the Video tab in the Meeting window.

Viewing Video in a Floating Window

Normally, video that a participant sends appears on your Video tab. However, 
you can view video in a floating window so it is always visible during a 
meeting. For example, if the presenter shares an application, you can still view 
video in the floating window. To do so, on the Video tab, click the View Floating 
Video Window button:

Using Annotation Tools 

When sharing a presentation, use the annotation tools to highlight text or 
graphics, emphasize points, and draw and write notes. If you are conducting 
a meeting with few attendees, you might want to allow attendees to annotate 
your presentation. Attendees can use annotation tools, for example, to point 
to areas on a slide about which they want to comment or ask a question.
Choosing an Option for Sharing Presentations or 
Documents

Your meeting service provides the following options for sharing a 
presentation or document: 

■ Sharing a presentation or document in the content viewer—The 
Presentation or Document command on the Share menu displays a 
presentation or document in the content viewer. If you used Microsoft 
PowerPoint to create your slides, the content viewer also displays any 
animations and transitions on the slides. This sharing option provides a 
set of annotation tools that both you and attendees with annotation 
privileges can use; viewing options, such as thumbnails and full-screen 
view; and simultaneous use of the entire Meeting window, including the 
participant list and chat.

■ Sharing a presentation as an application—Instead of displaying a 
presentation or document in the content viewer, you can open the 
presentation or document in the application with which it was created, 
and then share the application. Sharing a presentation or document as an 
“application” lets you or an attendee edit the slides or pages during the 
meeting. However, while you are sharing an application, the Meeting 
window is not available, including the toolbar, the participant list, chat, 
and so on. 

■ Sharing a presentation or document by sharing your desktop—Sharing 
your desktop provides the same benefits as sharing your presentation as an 
application. However, desktop sharing lets you show any part of your 
desktop to attendees and quickly share additional applications.

Choosing an Option for Sharing Web Pages

During a meeting, you can display Web pages to attendees in one of three 
ways:

■ Web browser sharing—Web browser sharing allows you to take attendees 
on a “Web tour.” Attendees can view each Web page that you access, either 
on the Internet or on your organization’s private intranet. You can 
optionally allow attendees to control your Web browser. This option uses 
more bandwidth than the following two options.
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■ Web content sharing—To share a Web page on the Internet that includes 
multimedia effects, such as sound and animation, you can use Web 
content sharing. This option lets you specify a URL for a Web page, video, 
audio file, flash file, or WebEx Recording, and display the content in the 
content viewer on each attendee’s screen. Attendees can hear sounds and 
interact with other multimedia effects independently in their content 
viewers. This option also lets you share a single Web page more quickly 
than you can using the Web browser sharing option; however, it does not 
allow you to guide attendees to other Web pages.

■ Presentation sharing—Using the WebEx Universal Communications 
Toolkit, you can insert a link to a Web page directly in a Microsoft 
PowerPoint presentation. When you share the presentation in the content 
viewer during a meeting, using the Presentation or Document command on 
the Share menu, the Web page automatically appears on the slide on which 
you inserted its link. This option is useful if you want to include a Web 
page in your presentation but do not want to stop your presentation to use 
either Web browser sharing or Web content sharing. For more 
information about creating and sharing presentations in which you insert 
media objects, see “Using UCF Multimedia to Enhance Your 
Presentation” on page 8.

Providing Handouts to Attendees

You can let attendees print handouts at any time during a meeting, as follows:

1 Share the handout by choosing Presentation or Document on the Share 
menu, and then selecting the handout document.

The handout appears in the content viewer.

2 On the Participant menu, choose Privileges.

3 In the Attendee Privileges dialog box, select the Print check box, and then 
click Assign.

Attendees can now print the shared handout by pointing to Print on the File 
menu, and then choosing Document.
Synchronizing Displays

When you share a document or presentation in the content viewer, some 
attendees may not be able to view the entire page or slide that you are sharing, 
because their viewers are set to different magnifications. To resolve this 
problem, simply click the Synchronize button on the toolbar.

All attendees’ content viewers then display the page or slide at the same 
magnification that you set in your viewer.

Improving the Performance of Document or 
Presentation Sharing

You can improve the speed at which shared pages or slides appear to attendees 
by doing any of the following: 

■ Limit the number of animations and slide transitions that you add to 
Microsoft PowerPoint slides.

■ Minimize the number of screen captures that you add to slides, especially 
if they are bitmap graphics. Such graphics do not compress well.

■ Do not include more than 20 to 30 slides in one presentation file. If you 
want to share more slides, create a separate presentation file for each set of 
20 to 30 slides.

■ Keep the size of the presentation file to a maximum of 5 MB.

Displaying Animations and Slide Transitions

When sharing a Microsoft PowerPoint slide presentation in the content 
viewer, you can display animations on the slides and slide transitions.

Once you begin sharing a presentation, you can perform slide transitions or 
animations, as follows:

1 Click anywhere in the content viewer to set the input focus. A blue border 
around the shared slide indicates that the viewer has input focus.

2 Do either of the following:
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■ To perform the next slide transition or animation, click the Next button 
on the toolbar.

■ To perform the previous slide transition or animation, click the 
Previous button on the toolbar.

.

You can also use the keys on your keyboard to perform slide transitions or 
animations, or to navigate your slides:

N o t e If you are unable to display animations or slide transitions, 
ensure that you import the presentation using the Universal 
Communications Format (UCF) import mode: On the Meeting menu, 

choose Options, and then click the Import Mode tab.

Using UCF Multimedia to Enhance Your Presentation

You can make an online meeting more engaging by sharing any of the 
following types of media files in the content viewer:

■ WebEx Recording Format (WRF) files

■ video files

To... Press...

Display the next slide or perform the next 
animation or slide transition

Space Bar, Page Down, Right 
Arrow, or Down Arrow

Display the previous slide or perform the 
previous animation or slide transition

Page Up, Left Arrow, or Up Arrow

Display the first slide Home

Display the last slide End
■ audio files

■ Flash movie and interactive Flash files

■ Web pages

To share a media file, you must use a Universal Communications Format 
(UCF) media object. A media object links to the media file and provides a 
window in which the file appears. An object also contains options and 
controls for displaying or manipulating the file.

You can share media files in either of two ways:

■ In a Microsoft PowerPoint presentation—Using the WebEx Universal 
Communications Toolkit, a plug-in for Microsoft PowerPoint, you can 
insert UCF objects into your slides. You can then share the presentation 
during a meeting.

You can download the Universal Communications Toolkit from the 
Support page on your meeting service Web site.

■ As a standalone file—You can share a media file directly in the content 
viewer. Meeting Manager creates a UCF object for the file automatically, 
which appears in the content viewer.

For more information about creating UCF multimedia presentations, 
refer to the guide Getting Started with WebEx Universal 
Communications Toolkit. For more information about sharing either 
a UCF multimedia presentation or a standalone media file, refer to the 
online Help on your meeting service Web site.

Sharing Graphics Quickly

You can quickly share a graphics file with attendees by copying it to your 
computer's clipboard, and then pasting it in the content viewer. To copy an 
image, do one of the following:

■ Right-click an image on a Web page or in a document, and then choose 
Copy.

■ Capture the active window on your desktop to an image by holding down 
the Alt key and pressing the PrtScn (Print Screen) key.

■ Capture your entire desktop to an image by pressing the PrtScn (Print 
Screen) key.
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Once you copy an image to your computer's clipboard, on the Edit menu in 
the Meeting window, choose Paste Page Image.

You can paste any bitmap image in the content viewer, such as a GIF, JPEG, 
BMP, or TIF image. However, you cannot paste other types of images—such 
as EPS or Adobe Photoshop (PSD) images—in the content viewer.

Optimizing Attendees' Shared Views

The following tips can help you to avoid common problems with application, 
desktop, or Web browser sharing:

■ Differences in screen resolution settings between your computer and an 
attendee's computer may prevent that attendee from viewing the entire 
application, desktop, or Web browser that you are sharing. To help avoid 
this problem, you can do any of the following:

Ask attendees to reduce the image of the shared software, by clicking 
the Sharing button in the upper-right corner of the sharing window, 
and choosing an option for the Viewing Size command.

Ask all attendees to set their monitors to the same screen resolution as 
your screen. 

Set your monitor to a lower screen resolution, such as 800 by 600 pixels. 

For instructions on setting screen resolution, refer to Windows online 
help.

■ You can also resolve some problems with screen resolution by choosing 
the Show Full-Screen View for Attendees command on the Sharing menu, 
which appears in the title bar of the application or Web browser that you 
are sharing.

■ To improve the quality of attendees' views of a shared application, ensure 
that your screen display and attendees' screen displays are set to the same 
color depth—for example, 16-bit color.

For instructions on setting screen color depth, refer to Windows online 
Help.
Communicating Your Monitor Settings to Attendees

To optimize application, desktop, or Web browser sharing, you and attendees 
should set your monitors to the same screen resolution and color depth (see 
“Optimizing Attendees' Shared Views” on page 9). As a presenter, you can 
specify the screen resolution or color depth to which attendees should set 
their monitors in the following ways:

■ Once you start a meeting, type the monitor settings in a chat message to all 
attendees. Remember to resend the message periodically, because 
attendees cannot view any chat messages that you send before they join a 
meeting. 

■ Include the monitor settings on either the first slide of your presentation 
or in the header on each slide.

■ Type the monitor settings on a shared whiteboard.

■ Share a document that includes the monitor settings.

Opening Applications Before a Meeting Starts

To save time during a meeting, begin sharing one or more applications before 
the meeting's starting time, and then minimize their windows. At the 
appropriate time during the meeting, you can quickly begin sharing an 
application by restoring its window, without waiting for the application to 
start.

Improving the Performance of Software Sharing

To improve the performance of software sharing, do the following:

■ Close all applications that you do not need to use or share on your 
computer. Closing applications conserves processor usage and memory 
on your computer, thus helping to ensure that Meeting Manager can send 
images of shared software quickly during a meeting.

■ To ensure that the maximum amount of bandwidth is available for 
software sharing, close any applications on your computer that use 
bandwidth, such as instant messaging or chat programs, and programs 
that receive streaming audio or video from the Web.
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■ Ensure that the Meeting Manager display mode is set optimally for the 
application that you are sharing. You can choose one of two display 
modes: one for normal applications and another for graphics-intensive 
applications. To set the display mode, on the Meeting menu, choose 
Options.

Avoiding Blocked Views

If you cover a shared application or Web browser with another window on 
your computer's desktop, attendees cannot view the area of the application or 
browser that the other window covers. Instead, a crosshatched pattern appears 
in the covered area on attendees' screens. To help avoid this problem, ensure 
that you minimize all applications that are running on your computer, and 
then restore the window for only the application or browser that you want to 
share. 

To ensure that you do not block a shared view and create the crosshatched 
pattern, use a second computer to join the meeting as an attendee and 
monitor the attendees' view of your presentation.

Transferring Files to Attendees

During a meeting, you can transfer any types of files to attendees, by choosing 
Transfer on the File menu. The following are some examples for using this 
option:

■ Provide attendees with a copy of your presentation or any other 
documents that you share during the meeting. 

■ If you are training attendees on how to install and use an application, 
provide attendees with the application's installation program. Then, use 
desktop sharing to show attendees how to install the software.

■ If you take a poll during a meeting, provide attendees with a copy of the 
poll results file that you saved. Attendees can open a poll results file using 
any text editor.
Recording Meetings

This section provides tips and techniques for using WebEx recording.

Recording Meetings for Remote Teams

If you want to give a presentation to a remote team in another time zone, you 
can record a meeting—including all interactions, sharing, and audio—using 
WebEx Recorder. You can then publish the recording on your organization’s 
Web site or intranet. Members of the remote team can use WebEx Player to 
replay the meeting at any time.

WebEx Recorder is integrated in the Meeting window. WebEx Player and a 
standalone version of WebEx Recorder are available on your meeting service 
Web site. For detailed instructions on using WebEx Recorder and Player, refer 
to the WebEx Recorder and Player User’s Guide.

Editing Your Recordings

Before you distribute or publish a recording that you made using WebEx 
Recorder, you can edit it to remove mistakes, long pauses, unwanted 
segments, and so on. To edit a recording, you must use WebEx Recording 
Editor, which is available on the Recording and Playback page on your 
meeting service Web site.

Streaming Recordings on Your Web Site

On your Web site, you can publish recordings that users have created using 
WebEx Recorder—that is, .wrf files. Then, anyone who visits your Web site 
can play the recordings by streaming them over the Internet. Streaming allows 
people to play the recordings without downloading them to their computers.

To stream recordings, you can use Create a URL for Recording page on your 
meeting service Web site. For more information, refer to the “Recording and 
Playback FAQ” on your site. This FAQ includes a link to the guide Streaming 
Recordings on Your Web Site.
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Hosting a Large Meeting

For meeting hosts

This section provides tips and techniques that can help you to host a meeting 
with a large number of participants more effectively.

Muting Audio

If you are using the integrated WebEx teleconferencing service, you can 
prevent distracting noises during a meeting by muting the audio for all 
participants in a teleconference. To do so, on the Participant menu in the 
Meeting window, choose Mute All.

Using Two Computers

To ensure that attendees can view shared presentations or applications 
properly, you (or the presenter) can monitor their view of the meeting by 
using two computers. Use one computer to present information, and use the 
other computer to view the meeting as an attendee.

Setting Up a Dual-Mode Voice Conference

If your meeting requires only one-way audio—that is, a meeting in which 
attendees listen to the presenter but do not speak themselves—you can set up 
a dual-mode voice conference. A dual-mode voice conference includes both a 
teleconference and an Internet phone conference. Attendees can choose to 
listen to audio using either their phones or speakers attached to their 
computers. For example, if joining the teleconference would require an 
attendee to make a long-distance call, the attendee could use Internet phone 
instead.
To set up a dual-mode voice conference, on the Teleconference page in the 
Schedule a Meeting Wizard, select both a teleconferencing option and Internet 
phone.

For detailed information about setting up a teleconference and using 
Internet phone, refer to the online Help on your meeting service Web 
site.

Providing Technical Support

Provide attendees with a phone number that they can call to receive support 
from your technical support personnel. Having this phone line available helps 
to ensure that all attendees can fully participate in a meeting. 

To avoid having attendees interrupt a meeting when they need help, provide 
your support number on the first slide in the content viewer, in the header of 
each slide, or in the agenda. 

Establishing Meeting Guidelines

To help keep a large meeting running smoothly, you can provide attendees 
with a list of meeting guidelines to follow. For example, you can specify how 
and when attendees can ask questions, request annotation control, request 
remote control, and so on. To provide your guidelines to attendees, you can 
do either of the following:

■ When scheduling a meeting, specify your guidelines in the agenda.

■ Include your guidelines on the first slide in your presentation. Once 
attendees join a meeting, they can read the guidelines before the 
presentation starts.

N o t e s

■ An Internet phone conference does not start automatically once you start 
a meeting. You must start the Internet phone conference as follows: On the 
Tools menu, point to Internet Phone, and then choose Start Conference.

■ To allow all attendees to hear audio, the presenter must speak into both a 
phone and a microphone attached to his or her computer.
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Designating a Chat Moderator

Chat provides a convenient way for attendees to ask questions during a large 
meeting. To ensure that attendees receive timely answers to their questions, 
and to avoid interrupting the meeting, you can designate another attendee as 
a chat moderator. The moderator can answer attendees' questions in chat 
messages. At the beginning of the meeting, instruct attendees to use chat to 
ask questions and to direct their questions to the chat moderator.

Handling Disruptive Attendees

To prevent a disruptive attendee from taking control away from the presenter, 
be careful when granting privileges to attendees. If an attendee continues to 
disrupt a meeting, you can expel the attendee by selecting the attendee’s name 
on the Participants tab, and then choosing Expel on the Participant menu.

Once you expel an attendee, you can prevent the attendee from attempting to 
rejoin the meeting by choosing Restrict Access on the Meeting menu.

Solving Common Problems

The following are tips for solving and avoiding some common problems that 
you may encounter when using your meeting service.

Using a Dial-Up Connection

Attendees who use dial-up connections to the Internet can avoid unnecessary 
delays in screen updates during a meeting by connecting to their local ISPs, 
rather than to their corporate servers. Connecting to a corporate server can 
cause delays in receiving meeting data because the data must traverse a longer 
path, and thus is more likely to traverse congested lines.

Testing Dial-Up and High-Speed Connections

If you use a dial-up connection, poor phone lines and equipment in your area 
may affect your meeting experience. If you suspect that such a problem exists 
in your area, contact your phone service provider.
Even if you use a high-speed connection—such as ISDN, DSL, T1, or T3—
you may experience bandwidth limitations or data loss. These problems may 
originate with your ISP or a major hosting facility in your area. For example, 
some ISPs use proxy servers to handle inbound and outbound network traffic. 
These servers can reduce your connection speed and thus affect the 
performance of your meeting service.

To determine the speed of your connection and whether any problems exist 
with your connection, you can use traceroute—a utility that records the 
route that data traverses on the Internet between your computer and a 
specified destination computer. 

To use traceroute on a Windows computer to test the connection between 
your computer and the computer that hosts your meeting service Web site, 
follow these steps:

1 On the Start menu, point to Programs, point to Accessories, and then 
choose MS-DOS Prompt or Command Prompt, depending on your 
computer’s operating system.

In the MS-DOS Prompt or Command Prompt window, type your meeting 
service Web site’s URL, which has the following format:

tracert <your_organization_name>.webex.com

where <your_organization_name> is the name of your organization.

2 Press Enter.

The traceroute results indicate how many hops—or routers—that data must 
traverse to reach your meeting service Web site, and the time it takes for data 
to reach your site, in milliseconds (ms). On a good connection, data takes 
between 15 to 100 ms to reach its destination. If the data's travel time is longer 
than 100 ms, your connection is slow. In this case, examine the results to 
determine where the data's path became slow. You can help to isolate a 
problem by tracing the route to a well-known Web site, such as 
www.yahoo.com, and comparing the results to those for the route to your 
meeting service site.
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Clearing Your Web Browser's Cache

Clearing your Web browser's cache can improve your browser’s performance, 
and thereby your meeting experience. To clear you browser's cache, follow 
these steps:

Internet Explorer 4.x

1 On the View menu, choose Internet Options. 

2 Under Temporary Internet files, click Delete Files.

Internet Explorer 5.x

1 On the Tools menu, choose Internet Options. 

2 Under Temporary Internet files, click Delete Files.

Netscape Navigator

1 On the Edit menu, choose Preferences. 

2 Expand Advanced.

3 Select Cache.

4 Click Clear Disk Cache.

Handling Firewall Problems

Your meeting service Web site sends and receives all meeting data through 
port 80—your firewall's standard HTTP port. You need not open any other 
ports on your firewall. If port 80 is open on your firewall but you still cannot 
use your meeting service Web site, please contact technical support.
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Contacting WebEx

Obtaining Assistance

To receive technical support for your meeting service, go to the Support page 
on your meeting service Web site, as follows:

1 On the navigation bar, expand Assistance.

2 Click Support.

Support contact information appears on this page.

Providing Feedback to WebEx

At WebEx, we value your comments about our software products and 
documentation. 

Providing Feedback About Your Meeting Service

To provide feedback about your meeting service you can send an email 
message to feedback@webex.com.

Providing Feedback About This Guide

If you have comments about this guide or other WebEx documentation, 
please send an email message to docs@webex.com. In your email message, 
please specify the section to which your comment applies. If you would like to 
receive a response to your comments, please include your name and contact 
information in your message. 


